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ABSTRACT 

. paper presents the design and simulation of Rectangular Micro strip Patch 

and Circular Micro strip Patch Antenna. This Antenna will provide the 

bandwidth by introducing in to rectangular patch. The antenna design ' IS 

"Dlated using HFSS software. The performance of the designed antenna was 

_ . hr:7Pf1 in terms of bandwidth, gain, return loss, VSWR and radiation pattern 

Dielectric Substrate Rogers RT/duroid 6002™ and Rogers RT/duroid 

S880TM having dielectric constant of 2.94 and 2.2 are used. This antenna design is 

simulated using HFSS simulator (High Frequency Structure Simulator). The 

r ... tenrta is able to operate at 7.5 GHz frequency band. 
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Chapter 1 

Fundamental of antenna 

this chapter we will learn the basic fundamentals of antennas. The word antenna is a 

module of any wireless and Radio communication system is a device that has an 

. "ty of transmission and reception of electromagnetic energy. According to IEEE 

dard definitions of terms for antenna (IEEE StdI45-1983) defines antenna as a way 

of radiating or receiving radio waves[ IJ; More broadly, antenna at the transmitting end 

transforms the information signal into an electromagnetic energy and transmits it via free 

space as a source of medium and at the receiving side the electromagnetic wave is 

received as a result information signal by conversion process is received, this treatment 

know how to as transducer. In erstwhile _ prose, it is switch from a guided wave 

transmission procession to unguided energy in free space ,at the receiving end the reverse 

process is been done devoid of intervening arrangement[ 1]. The frequencies for carrying 

this communication can be consulted from electromagnetic spectrum [1]. 

1.2 Patch Antenna 

Microstrip patch Antennas (also just called patchantennas) are among the most common 

antenna types in use today, particularly in the popular frequency range of 1 to 6 GHz. 

This type of antenna had its first intense development in the 1970s, as communication 

systems became common at frequencies where its size and performance were very useful. 

At the same time, its flat profile and reduced weight, compared to parabolic reflectors and 

other antenna options, made it attractive for airborne and spacecraft applications. More 

recently, those same properties, with additional size reduction using high dielectric 

constant materials, have made patch antennas common in handsets, GPS receivers and 
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_D-!nmouced wireless products.Now a day, micro strip patch antennas are the 

CIOIDIDOO antenna types in use. Often micro strip antennas are also referred to as 

.mennas. These antennas are low-profile., comfortable to planar and non-planar 

simple and inexpensive to manufacture using modem printed-circuit 

performance applications, where Slze, weight, thickness, material, cost, 

ldi]lIlltanc:e ease of installation are constraints, low profile antennas may be required. 

there are many other applications. Such as mobile radio, wireless communications, -

have also similar specifications. To fulfill the requirements, micro strip patch 

_ aullaS can be used. Its' frequency range is about 1 ~ 20 GHz. As the frequency is 

CIIIDDl,on frequency range for communication system the micro strip patch antennas are 

_ !fhr used. In GPS receiver, handsets and other mass-produced wireless products, patch 

_ ennas are used. 

,-

L 
Patch 

+ t _ . ......... . 

·f 
Dielectric Substrate 

h ! 
Ground Plane 

Fig.1 :Microstrip Patch Antenna 
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Chapter 2 

Architecture of Patch Antenna 

strip patch antenna consists of radiation patch, dielectric substrate and ground plan 

shown in figure 2.1. 

w 

Ground 

Fig 2.1: Structure of a Micro strip Patch Antenna. 

The following figure shows a patch antenna in its basic architecture. The patch and the 

ground plane are separated by a dielectric material. A flat plate over a ground plane and 

then the dielectric substrate at the center and the patch is at the top. The patch and the 

ground plane are generally conducting materials such as gold, copper and the patch can 

be any shape as the design specification. The feed line is used to feed the patch. There are 
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different types of feeding techniques. Usually, the patch and the feed line are photo 

radiating patch can be square, rectangular, circular, triangular, elliptical, circular ring 
dipole and so on. 

Rectangular Circular Triangle 

Circular ring Dipole Elliptical 

Fig 2.2:Common shapes of micro strip patch elements. 

2.2 Basic Characteristics 

To design the micro strip antenna for specific resonant frequency, we have to consider 

about the material of the patch, the dielectric constant of the substrate also the size of the 

patch and the substrate. 

For a rectangular patch, the length, L of the patch is usually 0.3333..1,0 < L < 0.5..1,0 ; where Ao 

free space wave length. The patch must be selected to be very thin such that t < < ..1,0 ; 

where t is the thickness of the patch. The height h of the diele_ctric substrate is usually 

4 



_v .. n~ ~ h ~ 0.05,1,0 . [The dielectric constant of the substrate (s r) is typically in the range 

~ S r ~ 12]. There are many substrates that can be used for the design of the patch 

_ leIllnasand their dielectric constants are usually in the range of2.2:=;sr:=;12. Because of 

the better efficiency, larger bandwidth and better radiation, a thick dielectric 

substrates with higher dielectric constants are desirable but they are less efficient and 

ve relatively smaller bandwidth. A compromise has to be reached between good 

tenna performance and circuit design. 

1.3 Advantages and Disadvantages 

We know antennas are used in wireless applications. Micro strip patch antennas are 

increasing its popUlarity due to its low profile. Patch antennas are exclusively used in 

band held devices like GPS receivers, cell phones, pagers, radio etc. Patch antennas are 

also used in spacecraft, satellite and missile applications. 

Some of their main advantages are: 

1. high weight and small overall volume/dimension, 

2. possibility of printing on curved surfaces to make conformal antennas, 

3. fabrication cost is low, 

4. supports both circular and linear polarization, 

5. easily integrated with electric components, 

6. capable of dual and triple frequency operations, 

7. easily manufacturing using printed circuit technology 

Some of their main disadvantages are; 

1. relatively narrow frequency bandwidth, 

2. low frequency, 

3. low power handling capacity, 

4. poor polarization purity, 

5 



s. low gain, 

6. spurious feed radiation, 

7. high quality factor 

micro strip patch antennas have a large quality factor, Q so the antennas are low 
and also narrow bandwidth. But there are low efficiency and also narrow 
. But there are methods, such that the height of the substrate and that can be 

to extend the efficiency and bandwidth. But as the height increases, surface waves 
introduced which are not describable: because given total power goes into the surface 

The surface waves travel within the substrate and they are scattered at bends and 
the antenna pattern and polarization characteristics. Surface waves Can be 

........ u.u .... ~"' ... while maintaining large bandwidths by using cavities. [2][3].However, the 
I_'&~"_ wave can be minimized by use of photonic band gap structures. 

6 



Chapter 3 

Feed Methods 

are many techniques that can be used to feed mIcro strip antennas. These 

recnruLques are classified into two categories - contacting and non-contacting. In 

technique the RF power is fed directly to the radiating patch with micro strip 

e. In non-conducting technique, the electromagnetic field coupling is done to transfer 

wer between the micro strip line and the radiating patch. The four most popular are the 

micro stripe line feed, coaxial feed, aperture coupled feed, proximity coupled feed. 

3.1 Micro strip Line Feed 

Micro strip feed line is also a conducting strip, usually of much smaller width compared 

to the patch. The micro strip line feed is easy to fabricate, simple to match by controlling 

the inset position and rather simple to mod~l. The conducting strip is directly connected 
, 

to the edge of the micro strip patch. The feed line also can be etched on the same 

substrate to provide a planar structure. The micro strip line and the patch are impedance 

matched so there is no need for any additional matching elements. This is done by 

properly controlling the inset position. However, as the substrate thickness increases, 

which for practical designs limit the bandwidth of the antenna [4]. 

Micro Strip Feed Patch 

Substrate 

Ground plane 

Fig 3.1:Micro Strip Line Feed. 
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Coaxial Feed Line 

know coaxial feed cable has inner conductor and outer conductor. In coaxial feed the 

conductor is connected to the radiating patch and the outer conductor is connected 

the ground plane figure: 3.2. In this technique, the feed can be attached at any desired 

ion in the radiating patch in order to match its input impedance. Coaxial feed line is 

easy to fabricate and match it has low spurious radiation. However, it has narrow 

dwidth and it is more difficult to model, especially for thick substrates (h < O.02Ao ) 

feed line and the coaxial line feed inherent asymmetries which 

generate higher order modes which produce cross-polarized radiation. To overcome some 

of these problems, non conducting aperture coupling feeds. Now we discuss the non

conducting feed techniques which have been discussed below. 

Patch 

Substrate ...... ---

Ground plane 

Coaxial connector 

Fig. 3.2:Probe fed Rectangular Micro strip Patch Antenna. 
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Aperture Coupled Feed 

this technique, the radiating patch and the micro strip feed line are separated by the 

BOUllO plane as shown in figure: 3.3. The aperture coupling consists of two substrates 

. mated by a ground plane [4]. The radiating patch and the feed line also separated by 

ground plane. Coupling between the patch and the feed line is made through a slot or 

aperture in the ground plane. The coupling aperture is usually centered under the patch 

leading to lower cross-polarization due to symmetry of the configuration. On the bottom 

• e of the lower substrate there is a micro stripe feed line whose energy is coupled to the 

patch through a slot on the ground plane separating the two substrates. 

The amount of coupling from the feed line to the patch is determined by the shape, size 

and location of the aperture. Generally, a high dielectric material is used for the bottom 

substrate and a thick, low dielectric constant material is used for the top substrate · to 

optimize radiation pattern from technique is that it is difficult to fabricate due to multiple 

layers, which also increases the antenna thickness. This feeding scheme also provides 

narrow bandwidth. 

Patch 

Micro strip Line 

Ground Plane 

~~.. Aperture/Slot 

..... ------!oooifnhdlol::ltf' 1 

r------+ Substrate 2 

Fig. 3.3 :Aperture-coupled feed. 
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coupled feed is also called electromagnetic coupling and it is also non

feed technique. Similar to aperture coupled feed, in this technique, there are 

substrates. The feed line is between the two substrates and the patch is the top of the 

strate, as shown in the figure: 3.4. 

'cro strip Line 

,-

------. Substrate 1 

'----. Substrate 2 

Fig. 3.4:Proximity-coupled Feed. 

The main advantage of this technique is that it has low spurious radiation and it has the 

largest bandwidth (as high as 13%) [4][5]. As 2 substrates are used, the thickness of the 

antenna is increased. This technique also provides choices between two different 

dielectric media, one for the patch and one for the feed line to optimize the individual 

performances. Matching can be achieved by controlling the length of the feeding stub and 

to control the match [6]. Though, the fabrication of the two dielectric layers, need proper 

alignment but it is easy to model. 

10 



fTable 3.1 : Comparing the different feed techniques 

Characteristics Micro strip Coaxial Fe~d Aperture Proximity 
Line coupled Feed coupled Feed 
Feed 

Spurious feed More More Less Minimum 
" radiation 

Reliability . Better Poor due to Good Good ' 
soldering 

Ease of Easy Soldering and Alignment Alignment 
fabrication drilling required required 

needed 
Impedance Easy Easy Easy Easy 
Matching 

Bandwidth 2-5% 2-5% 2-5% 13% 
(achieved with 

impedance 
matching) 
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Chapter 4 

Methods of Analysis 

There are many methods of analysis for patch antenna, they are transmission line model 

[7] [8], cavity model and full wave model [9] [lO].The transmission line model is the 

easiest of all, it gives good physical insight, but it is less accurate and it is more difficult 

to model coupling. Compare to transmission line model, the cavity model is more 

accurate but it is more complex [11] [12] [13]. The full wave models are extremely 

accurate, versatile and can treat single elements, finite and arrays, stacked elements, 

arbitrary shaped elements and coupling. However, they are most complex models and 

usually give less physical insight. 

4.1 Transmission Line Model 

We know that the transmission line model j s the easiest of all but if yields the least 

accurate results. This model represents the micro strip antenna by two slots of width, W 

and height h, separated by transmission line of length, L. This is a nonhomogenous line of 

two dielectrics, typically the air and substrate. 

Strip Conductor 

Fig 4.1 : Micro strip Line. 

Dielectric Substrate 

Ground Plane 
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Fig. 4.2:Electric Field Lines. 

From the figure: 4.2we see that most of the electric field lines reside in the substrate and 

parts of some lines exist in the air. As Llh» I and &,»1, the electric field lines 

concentrates mostly in the substrate. For this reason, this transmission-magnetic (TEM) 

mode of transmission, since the phase velocities would be dimension of the patch are 

finite along the length and width, the fields at the edges of the patch undergo fringing 

since some of the waves travel and some in air, an effective dielectric constant & ,ef! is 

introduced to account for fringing and the wave propagation im the line. The value of & ref! 

is slightly less than &, because the fringing fields around the periphery of the patch are 

not confined in the dielectric substrate but are also spread in the air as shown in figure: 

4.2. The expression for &,ef! is given by Balanis as: [14] 

Where, & , ef! = Effective dielectric constant 

&, = Dielectric constant of the substrate 

h = Height of dielectric substrate 

W = Width of the patch 

13 



Micro strip Feed Patch 

Ground Plane z 

Fig. 4.3:Micro strip Patch Antenna. 

Consider, from the above figure: 4.3, which shows a rectangular patch antenna of length 

L, width W resting on a substrate of height h. The co-ordinate axis . is selected such that ' 

the length is along the x direction; width is along the y direction and the height is along 

the z direction.In order to operate in the fundamental dominant TM 10 mode, the length of 

the patch must be slightly less than ,1/2 where A is the wave length in the dielectric 

medium and equal to ,10 / ~ e reff ; where ,10 is the free space wave length. 

The TM 10 mode implies that the field varies are ,1/2 cycle along the length, and there is 

no variation along the width of the patch. From the figure 4.4, the micro strip patch 

antenna is represented by two slots, separated by a transmission line of length Land 

open circuited at both the ends. Along the width of the patch, the voltage is maximum 

and the current is minimum due to the open ends. The fields at the edges can be resolved 

into normal and tangential comparatives with respect to the ground plane. 

14 



Radiating Slot Ground Plane 

L 

Fig. 4.4:Top View of Antenna. 

h 

Fig. 4.5:Side View of Antenna. 

It is shown from the figure: 4.5that the normal components of the electric field at the two 

edges along the width are in opposite directions and thus out of phase since the patch is 

AI2 long and have they canceled each other in the both side directions. The tangential 

components which are in phase means that the resulting field combines to give maximum 

radiated field normal to the surface. Hence, the edges along the width can be represented 

as two radiating slots, which are A I 2 apart and excited in phase and radiating in the half 

space about the ground plane. The fringing fields along the width can be modeled as 

15 



~.a"llJLF, slots and electrically the patch of the micro strip antenna looks greater than its 

dimensions. 

dimensions of the patch along its length have now been extended on each end by a 

-.stance M." which is given empirically by Hammerstad [15], 

W 
AI (Greff +0.3)(;;-+0.264) 
- = 0 412------'-~--h . W 

(Greff - 0.258)(- + 0.8) 
h 

Since the length of the patch has been extended by M., on each side, the effective length 

of the patch is now 

c 
L iff =--== 

e 2fo~Greff 

For a rectangular micro strip patch antenna, the resonant frequency for any TM mn mode is 

given by James and Hall [16] as: 

I 

fo = 2k[(~)2 +(; J]' 

Where m and n are modes along Land W respectively, for efficient radiation, the width 

W is given by Bahl and Bhartia [17] as 

c 
W=---=== 

2fo~(Gr 2+ 1) 
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_~la parameters are used to characterize performance of an antenna when designing 
measuring antennas. In this Section, terms like bandwidth, radiation pattern, gain, 

~ui2~aHon. input impedance are explained . 

. 1 Bandwidth 

The properties of input impedance, polarization, gain of an antenna do not necessary vary 
in the same manner moreover there is no distinctive characterization of the bandwidth. To 
calculate percentage of bandwidth: 

4.2.2 Radiation Pattern 

The radiation pattern of microstrip Patch Antenna is the power radiated or received by the 
antenna. It is the function of angular position and radial distribution from the antenna. 

4.2.3 Return Loss 

Power will not deliver to the load and is a return of the power, that is called loss, and this 
loss that is returned is called the return loss. Larger return loss indicates higher power 
being radiated by the antenna which eventually increases the gain. 

RL. == 10 loglo P in (dB) 
Pre! 
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ratio of the radiation intensity in a prearranged direction from the antenna to the 

.. auem intensity averaged over all directions, the average radiation power intensity is 

ent to the radiated power by the antenna divided by 4n". 

ptJ 4 n: 

4 rrIE (r)F 

JIE (r) 12 di2 

The ratio of the power radiated or received by meticulous antenna in a prearranged 

direction, to the power radiated or received by a taking reference ideal isotropic antenna 

in cooperation fed by the similar power. Due the isotropic as ideal antenna we take in dBi 

as reference unit. 

4.2.6 Input Impedance 

The input impedance of an antenna is defined as "the impedance presented by an antenna 

at its terminals or the ratio of the voltage to the current at the pair of terminals or the ratio 

of the appropriate components of the electric to magnetic fields at a point". 

4.2.7 Voltage Standing Wave Ratio (VSWR) 

The VSWR is an important specification for all communication devices. It measures how 

well an antenna is matched to the cable impedance. 

18 



ChapterS 

Introduction to HFSS 

HFSS is a high-performance full-wave electromagnetic (EM) field simulator for 
arbitrary 3D volumetric passive device modeling that takes advantage of the familiar 

. crosoft Windows graphical user interface. It integrates simulation, visualization, solid 
modeling, and automation in an easy-to-Iearn environment where solutions to your 3D 
EM problems are quickly and accurately obtained. Ansoft HFSS employs the Finite 
Element Method (FEM), adaptive meshing, and brilliant graphics to give you 
unparalleled performance and insight to all of your 3D EM problems. Ansoft HFSS can 
be used to calculate parameters such as S Parameters, Resonant Frequency, and Fields. 

5.1 HFSS USES 
Typical uses include: 

• Package Modeling 
BGA, QFP, Flip-Chip. 

• PCB Board Modeling 
Power/Ground planes, Mesh Grid Grounds, Backplanes. 

• Silicon/GaAs 
Spiral Inductors, Transformers. 

• EMC/EMI 
Shield Enclosures, Coupling, Near- or Far-Field Radiation 

• AntennaslMobile Communications 
Patches, Dipoles, Horns, Conformal Cell Phone Antennas, Quadrafilar Helix, Specific 
Absorption Rate(SAR), Infinite Arrays, Radar Cross Section(RCS), Frequency Selective 
Surfaces(FSS). 

• Connectors 
Coax, SFPIXFP, Backplane, Transitions. 

• Waveguide 
Filters, Resonators, Transitions, Couplers. 

• Filters 
Cavity Filters, Microstrip, Dielectric, 

19 



S is an interactive simulation system whose basic mesh element is a · tetrahedron. 
's allows you to solve any arbitrary 3D geometry, especially those with complex 

es and shapes, in a fraction of the time it would take using other techniques. 
e name HFSS stands for High Frequency Structure Simulator. Ansoft pioneered the 
of the Finite Element Method (FEM) for EM simulation by developing/implementing 

hnologies such as tangential vector finite elements, adaptive meshing, and Adaptive 
Lanczos-Pade Sweep (ALPS). Today, HFSS continues to lead the industry with 
innovations such as Modesto-Nodes and Full- Wave Spice™. 
Ansoft HFSS has evolved over a period of years with input from many users and 
industries. In industry, Ansoft HFSS is the tool of choice for high-productivity research, 
development, and virtual prototyping. 

5.2 Getting Help 
If you have any questions while you are using Ansoft HFSS you can find answers in 
several ways: 

S.2.1 Ansoft HFSS Online Help 
Provides assistance while you are working. 

• To get help about a specific, active dialog box, click the Help button in the dialog box 
or press the F 1 key. 
• Select the menu item Help > Contents to access the online help system. 

• Tooltips are available to provide information about tools on the toolbars or dialog 
boxes. When you hold the pointer over a tool for a brief time, a tooltip appears to display 
the name of the tool. 
• As you move the pointer over a tool or click a menu item, the Status Bar at the bottom 
of the Ansoft HFSS window provides a brief description of the function of the tool or 
menu item. 
• The Ansoft HFSS Getting Started guide provides detailed information about using 
HFSS to create and solve 3D EM projects. 

5.2.2 Ansoft Technical Support 
1. To contact Ansoft technical support staff in your geographical area, please 'log on to 
the Ansoft corporate website, ansoft.com and select Contact. 
o Your Ansoft sales engineer may also be contacted in order to obtain this information. 

20 



Visiting the Ansoft Web Site 

computer is connected to the Internet, you can visit the Ansoft Web site to learn 
about the Ansoft company and products. 

From the Ansoft Desktop 
Select the menu item Help >Ansoft Corporate Website to access the Online Technical 

.,-.,on (OTS) system. 
From your Internet browser 

For Technical Support 

The following link will direct you to the Ansoft Support Page. The Ansoft Support Pages 
vide additional documentation, training, and application notes [18]. 

5.3 Ansoft Terms 

The Ansoft HFSS window has several optional panels: 
i. Project Manager 
ii. Message Manager 
iii. Property Window 
iv. Progress Window 
v. 3D Modeler Window 

These above managers and windows are shown in Fig. and their details are given in 
coming sections 
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Fig.5.1:Ansoft HFSS window. 
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Project Manager 

:rI')lec;l Manager which contains a design tree which lists the structure of the project is 
in Fig 5.2 

Project Manager Window 

Project - -i..-. hfss_coox_training 
- • HFSSModell +-----Hlf-DeSign 

6V Model 

D' Boundaries 

+ Excitations 

!f:P Mesh Operations 

.. 16 Analysis 

Design Automatioo - -f!--f-- + Optimetrics 
' ParamctriC c+ ~ Results 
·Optirntz.at ion 
.sensltivity +: &E Port Field Display 
' StatisliCilI + Field Overlays 

~ Radiation 

- Cl Definitions 

.. CJ Materials 

>+ --+-+H-Design Setup 
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Fig 5.2:Ansoft HFSS Project Manager. 

5.3.2 Message Manager 

A Message Manager that allows you to view any errors or warnings that occur before you 

begin a simulation is shown in Fig. 5.3 
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Fig 5.3:Ansoft HFSS Property Window. 

5.3.3 Progress Window 

PlOJ:.-e rty 
b~tons 

A Progress Window that displays solution progress is shown in Fig. 5.4 
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SoMng LumpPol't2 · 

I nAbo~ :] 

Fig 5.4:Ansoft HFSS Progress Window. 
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3D Modeler Window 

3D Modeler Window which contains the model and model tree for the active design is 
respectively. 
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Fig 5.5:Ansoft HFSS 3D Modeler Window. 
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Fig 5.7:3D Modeler Design Tree. 

5.4 Toolbars 

The toolbar buttons are shortcuts for frequently used commands. Most of the available 
toolbars are displayed in this illustration of the Ansoft HFSS initial screen, but your 
Ansoft HFSS window probably will not be arranged this way. 
You can customize your toolbar display in a way that is convenient for you. Some 
toolbars are always displayed; other toolbars display automatically when you select a 
document of the related type. For example, when you select a 2D report from the project 
tree, the 2D report toolbar displays, as shown in Fig.5.8 

Ansoft HFSS -Project4 -HFSSDesign2 -3D Modeler - [Project4 -HFSSDesign2 -Modelerj 
!l file Ed,t Vie" Project Dra;r Medel" HFSS Tcol; Window Help 
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i. @ ! c:::: :J: == 4: be c2 j" I [;::: h i; h 111 lvacwn iJ iModei iJ I B u I il1> ~ ~ C!; ,(~ ./ 

Fig 5.8:Ansoft HFSS Toolbars. 
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Ansoft HFSS Desktop 

Ansoft HFSS Desktop provides an intuitive, easy-to-use interface for developing 
RF device models. Creating designs, involves the following: 

1. Parametric Model Generation - creating the geometry, boundaries and 
excitations. 

11. Analysis Setup - defining solution setup and frequency sweeps. 

111. Results - creating 2D reports and field plots. 

tv. Solve Loop - the solution process is fully automated. 

To understand how these processes co-exist, examine the illustration shown In Fig.5.9 

Fig S.9:Ansoft HFSS Desktop. 

27 



Opening a HFSS project 

. s section describes how to open a new or existing project. 

5.6.1 Opening a New project 

To open a new project: 
i In an Ansoft HFSS window, select the menu item File> New. 
ii. Select the menu Project> Insert HFSS Design. 

5.6.2 Opening an Existing HFSS project 

To open an existing project: 
i. In an Ansoft HFSS window, select the menu File> Open. Use the Open dialog to select 
the project. 
ii. Click Open to open the project 
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Fig S.10:Opening a HFSS project. 
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7 Set Solution Type 

section describes how to set the Solution Type. The Solution Type defines the type 
results, how the excitations are defmed, and the convergence. The following Solution 

ypes are available: 

i Driven Modal - calculates the modal-based S-parameters. The S-matrix solutions will 
be expressed in terms of the incident and reflected powers of waveguide modes. 
ii Driven Terminal - calculates the terminal-based S-parameters of multiconductor 
transmission line ports. The S-matrix solutions will be expressed in terms of terminal 
voltages and currents. 
iii Driven Transient It employs a time-domain (''transient'') solver. Typical applications 
include, but are not limited to Simulations with pulsed excitations, such as ultra-wide 
band antennas, lightning strikes, electro-static discharge; field visualization employing 
short-duration excitations; time-domain reflectometry. 
iv. Eignemode- calculate the eigenmodes, or resonances, of a structure. The Eigenmode 
solver fmds the resonant frequencies of the structure and the fields at those resonant 

- frequencies 

5.8 Convergence 

i. Driven Modal - Delta S for modal S-Parameters. This was the only convergence 
method available for Driven Solutions in previous versions. 
ii. Driven Terminal New - Delta S for the single-ended or differential nodal S
Parameters. 
iii. Eigenmode- Delta F 

5.9 To set the solution type: 
Select the menu item HFSS > Solution Type 
Solution Type Window: 

• Choose one of the following: 
o Driven Modal 
o Driven Terminal 
o Driven Transient 
o Eigenmode 
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Click the OK button 
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Fig S.ll:Solution Type. 

5.10 Parametric Model Creation 

The Ansoft HFSS 3D Modeler is designed for ease of use and flexibility. The power of 
the 3D Modeler is in its unique ability to create fully parametric designs without editing 
complex macros/model history. The purpose of this section is to provide an overview of 
the 3D Modeling capabilities. By understanding the basic concepts outlined here you will 
be able to quickly take advantage of the full feature set offered by the 3D Parametric 
Modeler. 

30 



Chapter 6 

Patch Antenna Analysis 

In this analysis we use Rogers RT/duroid 6002(tm) material for the substrate. To fmd the 
acceptable gain at -10 dB. Here we took shape of the patch: (i) rectangular and (ii) 
circular. 

6.1 RT/duroid® 6002™ 

Microwave material was the first low loss and low dielectric constant laminate to offer 
superior electrical and mechanical . properties essential in designing complex microwave 
structures which are mechanically reliable and electrically stable. The thermal coefficient 
of dielectric constant is extremely low from -55°C to+150°C (-67°P to 302°P) which 
provides the designers of filters, oscillators and delay lines the electrical stability needed 
in today's demanding applications[19]. 

Fig 6.1:Rogers RT/duroid 6002TM. 
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Table 6.1:Data Sheet of Rogers RT/duroid 6002™ 

- ---~- - - -
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~~~, 
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6.2 Rectangular Patch 

The objective of this chapter is to show you how to create, simulate and analyze a 
microstrip patch antenna resonating at a frequency of 7.5 GHz as shown in Fig.6.2 

Patch~ ........ 

Feed Line 
y 

28.1 nUll 

16mm 

8mm 

A (0. 0,0) ---"'X-", -----t 

Top View 

Z t ___ \\. r.=2.A. 6. llUI
L

_l _--, ~ .. II' 

E == 2.94 H= 3.5 nun , 

32 nlll1 

............. Ground Plane 
Cross View 

Fig 6.2:Rectangular Patch Antenna. 
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or this rectangular patch analysis the value of dielectric constant( E 7) is 2.94, substrate 

terial is Rogers RT/duroid 6002 TM. The properties of Rogers RT/duroid 6002 TM is 
liven in Table 6.1. The coordinate of the feed is (12.9,0,0) and the substrate thickness is 
3.5 mm. 

6.3 Simulated Results of Rectangular Patch Antenna 

6.3.1 Return Loss 
The simulated return loss of the optimized antenna from HFSS is shown in Fig.6.3. At 
7.5 GHz a return loss of -1 0 dB is achieved. 

XY Plot 1 HFSSDesign1 ~ I 
0.00 

Curle Infa 

- dB(S(l,l)) 
Seilpl : Sweep 

-2.50 

-5.00 

::: -7.50 ... ... 
Ul 
iii 
11-10.00 

-12.50 

-15.00 

-17.50 
5. 0 6. 7. 0 8. 0 9. 0 10.1 

Freq [GHzI 

Fig 6.3:Return Loss of Rectangular Patch Antenna in HFSS. 
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The percentage bandwidth of the antenna is calculated using the formula described in 
chapter 4. 

% of BW= (f2 - fl)/fo *100% = 5.53% where fo = 5.78, fl= 5.59 and f2= 5.91. The 
percentage bandwidth calculated using the above formula is tabulated in Table 6.2 and 
Table 6.3 for different substrate thickness and feed position respectively. 
The dependence of percentage bandwidth on substrate thickness is shown in Fig 6.4 . It is 
found that at a thickness of3.5 rrun the maximum percentage bandwidth (5.53%) occurs. 

Table6.2:Data Sheet of Different thickness of Rogers RT/duroid 6002™ for % ofBW: 

Material Name Substrate fo fl f2 % ofBW= (f2- fl)/fo *100% 
Thickness 

(rrun) 
Rogers 
RT/duroid 0.45 5.88 5.85 5.91 1.02% 
6002(tm ) 
Rogers 
RT/duroid 0.58 5.90 5.85 5.94 1.52% 
6002(tm) 
Rogers 
RT/duroid 0.66 5.90 5.83 5.93 1.69% 
6002(tm) 
Rogers 
RT/duroid 0.794 5.91 5.84 6.00 2.70% 
6002(tm) 
Rogers 
RT/duroid 0.89 5.82 5.72 5.91 3.26% 
6002(tm) 
Rogers 
RT/duroid 0.99 5.81 5.71 5.90 3.27% 
6002(tm ) 

Rogers 
RT/duroid 1.5 5.78 5.62 5.90 4.84% 
6002(tm) 
Rogers 
RT/duroid 3.5 5.78 5.59 5.91 5.55% 
6002(tm) 
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Graph of Table 6.2 
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Fig 6.4:The dependence of percentage bandwidth on substrate thickness. 
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Table 6.3:Data Sheet of Different Feed position for % ofBW: 

Material Name Feed fo fl f2 % ofBW= (f2- f})/fo *100% 
Position 

PEe 9.9,0,0 5.85 5.81 5.90 1.5% 

PEe 10.94,0,0 5.78 5.59 5.91 5.53% 

PEe 11.9,0,0 5.72 5.54 5.89 6.12% 

PEe 12.9,0,0 5.70 5.52 5.88 6.31% 

PEe 13.9,0,0 5.71 5.55 5.89 5.95% 

PEe 14.9,0,0 5.84 5.79 5.86 1.19% 
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Graph of Table 6.3 
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Fig 6.S:The dependence of percentage bandwidth on different feed position. 
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Table 6.4:Dielectric Constant of different Materials substrate thickness at 0.794 nun: 

Material Name Dielectric fo fl f2 % ofBW= (f2- fl)/fo *100% 
Constant 

Rogers 
RT/duroid 2.2 6.89 6.84 6.92 1.16% 
5880(tm ) 

Rogers 
RT/duroid 2.94 5.91 5.84 6.00 2.7% 
6002(tm ) 

Neltech 
NH9350™ 3.5 5.5 5.45 5.58 2.36% 

Silicon-
Dioxide 4 5.19 5.16 5.22 1.15% 

Rogers 
RT/duroid 6.15 6.23 6.21 6.26 0.80% 
6006(tm) 

Marble 8.3 5.4 5.39 5.42 
0.55% 
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Graph Of Table 6.4 
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Fig 6.6:Dielectric Constant of different Materials thickness at 0.794 tnm. 
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Table 6.S:Dielectric Constant of different Materials substrate thickness at 3.5 mm: 

Material Name Dielectric fo fl f2 % ofBW= (f2- fl)/fo *100% 
Constant 

Rogers 
RT/duroid 2.2 6.32 6.10 6.52 6.64% 
5880(tm) 

Rogers 
RT/duroid 2.94 5.78 5.59 5.91 5.55% 
6002(tm) 

Neltech 
NH9350™ 3.5 5.39 5.22 5.51 5.30% 

Silicon-
Dioxide 4 5.10 5.00 5.23 4.50% 

Rogers 
RT/duroid 6.15 6.60 6.40 6.80 6.06% 
6006(tm ) 

Marble 8.3 5.80 5.67 5.90 3.96% 

41 



Graph Of Table 6.5 
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Fig 6.7 : Dielectric Constant of different Materials thickness at 3.Smm. 
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Table 6.6:Data Sheet of Different thickness of Rogers RT/duroid 5880™ for % ofBW: 

Substrate 
Material Name Thickness fo f} f2 % ofBW= (f2- f})/fo *100% 

(rom) 

Rogers 
RT/duroid5880(tm 0.794 6.68 6.59 6.78 2.84% 
) 
Rogers RT/duroid 
5880(tm) 0.99 6.60 6.46 6.71 3.78% 
Rogers RT/duroid 
5880(tm ) 1.5 6.50 6.32 6.62 4.61% 
Rogers 
RT/duroid5880(tm 2.5 6.41 6.20 6.61 6.39% 
) 
Rogers 
RT/duroid5880(tm 3.5 6.32 6.10 6.52 6.64% 
) 
Rogers RT/duroid 
5880(tm ) 4 6.30 6.10 6.49 6.19% 

Rogers 
RT/duroid5880(tm 4.5 6.26 6.10 6.42 5.11% 
) 
Rogers RT/duroid 
5800(tm) 5.5 6.10 6.00 6.21 3.44% 
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Graph Of Table 6.6 
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Fig 6.8:The dependence of percentage bandwidth on substrate thickness. 
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6.3.2 Input Impedance 

6.3.3 Radiation Pattern 

rET eta 1 £t'l 
1.B588e.e8~ 

9.9587e.e8S 
9. S377e.e8S 
8.7167e.e8S 
8.8957e.e8S 

7.m7e.e8S 
6.8537e.e83 
6.2327e.e8S 
5.6117e.ee3 
•. 9987e.e8S 
U697e.e8S 
3.7.87e.ee3 
S. lZ77e.e8S 
2. 5867e.ee3 
1. 8857e.e8S 
l.m7e.ee3 
6.mee.eez 

170 

-170 

SmiIh Chart 1 

" 

Fig 6.9:Input Impedance from HFSS. 
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Fig 6.10:3D polar plot from HFSS. 
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~.4 Circular Patch Antenna 

The objective of this chapter is to show you how to create, simulate and analyze a 
microstrip patch antenna resonating at a frequency of 7.5 GHz as shown in Fig 6.8 

o 25 50 (mm) 

Fig 6.11: Circular Patch Antenna. 
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For this circular patch analysis the value of dielectric constant( c,) is 2.94, substrate 

material is Rogers RT/duroid 6002 'Df. The properties of Rogers RT/duroid 6002 TM is 

given in Table 6.1. The coordinate of the feed is (12.9,0,0), radius is 5 mm, height 0.05 
and the substrate thickness is 3.5 nun. 

6.S Simulated Result of Circular Patch Antenna 

6.5.1 Return Loss 

The simulated return loss of the optimized antenna from HFSS is shown in figure. At 7.5 GHz a 
return loss of -1 0 dB is achieved. 

XY Plot 1 HFSSOesign1 ~ 
0.00 

Curi,lnfo 
-

- dl!(S(I ,I)) 

-2.50 Seilpl : S«eep 

-5.00 

-7.50 

~10.00 
,... 
~ 
~-12.50 

-15.00 

-17.50 

-20.00 

6. 7. 8. 9. 10.00 
Freq(GHzI 

Fig 6.12:Return Loss of Circular Patch Antenna in HFSS. 
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The percentage bandwidth of the antenna is calculated using the formula described in 
chapter 4. 

% of BW= (f2 - f) )/fo *1000/0 = 14.5% where fo = 8.43, fl= 7.92 and f2= 9.13. The 
percentage bandwidth calculated using the above formula is tabulated in Table 6.4 for 
different substrate thickness. 
The dependence of percentage bandwidth on substrate thickness is shown in Fig.6.10. It 
is found that at · a thickness of 3.5 mm the maximum percentage bandwidth (14.35%) 
occurs. 

Table 6.7:Data Sheet of Different thickness of Rogers RT/duroid 6002™ for % ofBW 

Substrate 
Material Name Thickness fo fl f2 % ofBW= (f2- fl)/fo *100% 

(mm) 
Rogers 
RT/duroid 1.30 9.10 8.99 9.21 2.41% 
6002(tm) 
Rogers 
RT/duroid 1.50 9.03 8.68 9.35 7.41% 
6002(tm) 

Rogers 
RT/duroid 2.50 8.70 8.18 9.29 12.75% 
6002(tm) 

Rogers 
RT/duroid 3.50 8.43 7.92 9.13 14.35% 
6002(tm ) 
Rogers 
RT/duroid 3.70 8.39 7.89 9.00 13.23% 
6002(tm ) 
Rogers 
RT/duroid 3.90 8.37 7.88 8.93 12.54% 
6002(tm) 
Rogers 
RT/duroid 5.00 8.20 7.80 8.60 9.76% 
6002(tm ) 

Rogers 
RT/duroid 
6002(tm ) 5.50 · 8.15 7.90 8.39 6.01% 
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Graph of Table 6.7 
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Fig 6.13: The dependence of percentage bandwidth on substrate thickness. 
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Table 6.8:Dielectric 0 ..... ofdiffamtMaterials substrate thickness at 3.5 mm: 

Material Name Dieledric fo f} f2 % ofBW= (f2- f})/fo *100% 
Constant 

Rogers 
RT/duroid 2.2 9.41 8.76 10 13.19% 
5880(tm ) 

Rogers 
RT/duroid 2.94 8.43 7.92 9.13 14.35% 
6002(tm ) 

Neltech 
NH9350™ 3.5 7.90 7.48 8.39 11.51% 

Silicon-
Dioxide 4 7.50 7.10 7.90 10.67% 

Rogers 
RT/duroid 6.15 6.24 6.00 6.50 8.01% 
6006(tm) 

Marble 8.3 5.52 5.37 5.68 5.61% 
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Graph of Table 6.8 
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Fig 6.14:Dielectric Constant of different Materials thickness at 3.5 mm. 
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6.5.2 Input Impedaace 

Smith Chart 1 

Fig 6.15:Input Impedance from HFSS. 

6.5.3 Radiation Pattern 
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Fig 6.16:3D polar plot from HFSS. 
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Chapter 7 

Conclusion 

In this paper we design rectangular patch antenna and circular patch antenna for different 

materials at different thickness (mm) using different substrate material (having different 

cr) and feed position by using High Frequency Structure Simulator (HFSS) software. The 

overall working of antennas was understood. The major parameters (such as Return Loss, 

Radiation Patterns, Directivity and Bandwidth) that affect design and applications were 

studied and their implications understood. In this project using various types of materials 

for substrate thickness for better bandwidth (%). For changing substrate thickness every 

materials have their best bandwidth (%) at a certain thickness. For rectangular patch, we 

used Rogers RT/duroid 6002™ (dielectric constant, Er is 2.94) as substrate material. For a 

thickness of 3.5 mm the maximum percentage bandwidth is 5.55%. For the same patch 

using Rogers RT/duroid 5880 ™ (dielectric constant Er is 2.2) with thickness of 3.5 mm 

the maximum percentage bandwidth is ~.64%. For the circular patch antenna we used 

Rogers RT/duroid 6002™ with thickness of 3.5 mm and dielectric constant (Er) is 2.94. 

We found that the percentage bandwidth of this circular patch is 14.35%. 

53 



References 

[1] C. A. Balanis, Antenna theory: analysis and design. Hoboken, NJ: Wiley Interscience 
2005. 

[2] R. J. Mailloux, "On the Use of Metallized Cavities in Printed Slot Arrays with 
Dielectric Substrates," IEEE Trans. Antennas Prop., Vol. AP-35, No.5, pp.447-487, May 
1987. 

[3] J. T. Aberle and F. Zavosh, "Analysis of probe-Fed Circular Microstrip Patches 
Backed by Circular Cavities," Electromagnetics, Vol. 14, pp. 239-258, 1994. 

[4] Antenna Theory,A.Balanis,Wiley,2ndedition(1997),Chapter14. ISBN 0-471-59268-4. 

[5] A. G. Demeryd, "Linearly Polarized Microstrip Antennas. " IEEE Trans. Antennas 
Prop., Vol. AP-24, No.6, pp. 846-851, November 1976. 

[6] D. M. Pozar and B. Kaufman, "Increasing the Bandwidth of a Microstrip Antenna by 
Proximity Coupling," Electronic Letters, Vol. 23, pp. 368-369, April 1987. 

[7] K. R. Carver and J. W. Mink, "Microstrip Antenna Technology," IEEE Trans. 

Antennas Prop., Vol. AP-29, No.1, pp. 2-24, January 1981. 

[8] 1. R. James, and P. S. Hall, Handbook of Microstrip Antennas, Vols. 1 and 2, Peter 
Peregrinus, London, Uk, 1989. 

[9] 1. E. Rana and N. G. Alexopoulos, "Current distribution and Input Impedance of 
Printed Dipoles," IEEE Trans. Antenna Prop., Vol. AP-29, No.1, pp. 99-105, January 
1981. 

[10] M. C. Bailey and M. C. Deshpande, "Integral Equation Formulation of Microstrip 
Antennas," IEEE Trans. Antenna Prop., Vol. AP-30, No.4, pp. 651-656, July, 1982. 

[11] A. G. Demeryd, "A Thearetical Investigation of the RectabgularMicrostrip Antenna 
Element," IEEE Trans. Antenna Prop., Vol. AP-26, No.4, pp. 532-535, July 1978. 

[12] K. Malkomes, "Mutual Coupling Between Microstrip Patch Antennas," Electronic . 
Letters, Vol. 18, No. 122, pp. 520-522, June 1982. 

[13] E. Penard and J. P. Daniel, "Mutual Coupling Between Microstrip Antennas," 
Electronic Letters, Vol. 18, No.4, pp. 605-607, July 1982. 

54 



[14] Y. T. Lo, D. Solomon, and W. F. Richards, "TQ.eory and Experiment on Microstrip 
Antennas, "IEEE Trans. Antennas Prop., Vol. AP-27, No.2, pp. l37-145, March 1979. 

[15] E. O. Hammerstad, "Equations for Microstrip Circuit Design," Proc. Fifth 
EuropeanMicrowave Con!, pp. 268-272, September 1975. 

[16] J. Bahl and P. Bhatia, Microstrip Antennas, Artech House, Dedham, MA, 1980. 

[17] C. A. Balanis, Advanced' Engineering Electromagnetics, John Wiley & Sons, New 
York, 1989. 

[18] Web Site: http://ansoft.comlsupport.pfm 

[19] www.regerscorp.com 

55 


